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General Description





	This program is a graphical editor for block diagrams and flowcharts, 	currently only in UNIX (X windows) environment. It is actually an What-You-See-Is-What-You-Get interface to the PIC language for line-based drawing, which means it’s expression ability is limited to that of the language. The pros, however, are quick and easy work with standard elements and readable/editable, environment independent output file format. 


This manual isn’t a PIC reference book (Kernighan’s PIC user manual is recommended), but more of a guide to creating PIC pictures without knowing PIC. Creating an easy-to-use, comprehensive set of tools for doing this has been the main goal of our work. 
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2. Introduction to WD PIC





2.2 Interface layout.


Upon entering our program, the screen should look like this :





�EMBED PBrush���





	The numbered areas functions are as follows :


1. Pic tokens.


The buttons in this area (Box ,Arc ,Line, Spline , Arrow, Move, Circle, Text, Ellipse) allow the user to draw basic picture elements simply by clicking on them. Note that clicking RMB (the Right Mouse Button) on them open a window that lets you change the parameters of the element.


2. Drawing direction.


Here the user can choose the direction in which s/he want to continue drawing. Current choice is highlighted.


3. Line Style Palette.


Lets the user choose style of borders/lines by highlighting the one s/he needs. 


4. Fill Style Palette.


Allows the user to modify color and pattern to fill with for following tokens. Six recently used patterns are shown; to redefine one of them, click RMB on it.


5. Text Editor.


               Here the user can directly add PIC code to his picture. The program will process each completed line and update areas 7,3 and 4 (or call it an error if there is one).This window captures all text input (except for menu shortcuts and dialog input) while program is running (so that typing b-o-x-; will add this line to the file and draw a default box).


6. Menu.


In menu area user can make file operations (Open, Save, etc.), edit operations (Cut, Copy, Paste, etc.), choose GUI layout (meaning  showing/hiding areas 1-5) and change default values for element size, grid frequency etc. Every operation in this area will be also represented (if possible in PIC) in picture file and text edit area.


7. Graphical Editor.


Allows user to write PIC program without actually writing any text. Every click in areas 1- 4 and menu commands like "Paste" will result in appropriate graphical output in this area. Here user can select tokens with LMB, to make loops and conditions from selected tokens with RMB pop-up menu and to adjust  tokens by Drag & Drop or from RMB pop-up menu. Every operation in this area will be also represented (if possible in PIC) in picture file and text edit area.





	Another very important tool is the pop-up menu which can be invoked by clicking RMB anywhere on the picture. It’s contents are context sensitive and vary according to the element you’ve clicked on - you’ll get a list of commonly used applicable options.


	Last but not least, keyboard can be used too. When you are in a dialog box, you can use ESC to cancel any action not yet confirmed, ENTER to confirm it and TAB to circle between input fields. When not in a dialog box, all text input goes to the text edit window, letting you to edit you picture file directly.





	To demonstrate the use of those tools, let us go through a simple example.�



2.3 Picture example.





	Imagine that what you want to say is “Hello … Actually, I’m sure you are sick and tired of this example, so probably what you want to say is that “Hello World!” is a stupid example. In WD-PIC 2.0 you can do this by those simple actions (if you make a mistake at any stage feel free to undo last changes by going to “Edit” menu and choosing “Undo”)  :


1) Click on the RIGHT direction button.


Click on the BOX button with RMB and fill in “Hello World!” in the label field.


Click on the Arrow button


Click on the Ellipse button with LMB


Click on the Ellipse you’ve just drawn with RMB and fill in “Stupid example” in the opened dialog (in the label field). Press OK to confirm


    changes.





Your screen should now look like this (with appropriate tool set replacing the numbers):





�EMBED PBrush���





	Now you can proudly say that you’ve drawn your first WD PIC picture.
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Editing a picture, or “How to make things right”





	WD PIC 2.0 has a number of tools for editing pictures, i.e. for correcting mistakes, adjusting picture elements and moving around parts of the picture.





3.1 UNDO/REDO.


	In WD PIC, there are no irreversible actions. If you think you made a mistake, you can click “undo” under “edit” menu and you action will be taken back. If you think you made a mistake undoing the action, click “redo” under same menu and you’re back where you started. The length of the “undo/redo memory” of WD PIC is limited only by system resources, however note that disk actions (load/save/new etc.) cannot be undone/redone and therefore cut the undo “return path” when executed, limiting it’s length.





3.2 Adjusting a picture element.


	There are two ways to adjust an element. One, very common in graphical interfaces, is by dragging it’s border/corner to the desired place (for resize) or dragging the hole element around (by “holding” the middle of it). The other option is to click RMB on the element and choose “refine” from the pop-up menu - you’ll get a dialog letting you change it’s properties. Either of the ways is, of course, element type dependent - line’s head/tail can be set to point to a new place without moving the other end, while boxes and ellipses can have their x : y ratio changed, arcs can have their radius adjusted, sequence of lines can be turned to spline and vice versa, etc. For any of those (if applicable) a button/input fields will appear in the “adjust element” dialog.





3.3 COPY/PASTE : 


	To avoid repeating same actions over and over again, in WD PIC there are area copy/paste actions. Area can be selected either by pressing LMB in an empty place in the picture, holding and dragging it across the picture. Once you let it go, all the elements it the rectangular area between the start and end point of the dragging will be selected. In similar matter and with similar effect, sequences of PIC commands can be selected in the text window. After selected, the area can be cut/copied to the clipboard by choosing Cut or Copy from the “Edit” menu. Then the contents of the clipboard can be pasted into your picture by choosing “Paste” from the same menu and showing the program with a mouse click (in picture or text file) were to put them. It can be also saved to disk as a separate file for later use, and you can also load a PIC picture into the clipboard - with “Load Sample” or “Save Sample” commands from the “Edit” menu.
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4. File functions, or “Your window to the world”





	WD PIC saves your work in PIC language format, which is actually a text batch file . The PIC representation of your work can be seen and edited in the text edit window at the bottom of the screen. As it can be seen, PIC gives a relatively intuitive and simple description of the picture.


	All the file functions are located in the “File” menu. “Save” lets you save your work for later reference, “Load” - to read such work. “New”


is actually equivalent to loading file which doesn’t exist yet on the disk.


“Quit” - well, you can guess it yourself.
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5. Special commands, or “How to make things pretty”





	Actually, this chapter contains of options which didn’t fit into previous chapters, being too rarely used/non-trivial to be given in a tutorial. 





GRID & GRAVITY.


Working your way through the tutorial, you may have noticed that the elements you put in the picture seem to be aligned automatically according to some kind of invisible guidelines. Those guidelines are called the GRID, and by default all element’s dimensions and coordinates are multiplies of the grid size. This way the program can translate inaccurate mouse clicks and drags into a nice straight picture. This default can be turned off and back on by clicking (checking) on the “gravity” button under “defaults” in the main menu. If you wish to adjust the grid resolution, go to “defaults”, then “grid” and you’ll get a dialog box letting you adjust all grid settings.


Note that gravity works not only towards grid points, but also towards picture element’s corners and centers of borders, so that “line from left upper corner of this box to the right side center of the big one”


will always look like one, even if your mouse aim isn’t that good. These relations are also represented in the PIC code for the picture, so that they are preserved when elements are moved around, grid resized, etc.





4.2 LINE & FILL STYLE.  These attributes can be set by clicking in the line/fill palette areas on the appropriate pattern. Note that those settings are global and affect all lines/fills you make after you set them.
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6. WD PIC as a programming language interface,


or “How to make things work”





	Since the start of the document, the fact that there is a programming language behind WD PIC has been intentionally hidden from you. However, being what it is, PIC programming language lets you do things you can’t do with any picture editor, and our program lets you tell PIC to do this without actually writing any code.





5.1 Variables & blocks.


	WD PIC allows you to add blocks and parameter values to the picture, just like PIC does. To do so, select a part of the picture (by any of the means described in Editing section), click RMB on the picture and choose “Make Block” from the pop-up menu. You’ll get a dialog box asking for variable assignments - it lets you replace any numeric constant appearing inside the block (at all it’s appearances) with a variable name. This picture area will be then turned into a PIC block and the variable will be assigned with the constant value at the beginning of it. From now on,


this block can be treated as a “black box” by all WD PIC commands.


To declare/reassign variable within an existing block, click RMB on it and choose Edit Block from the pop-up menu.





Ifs & Loops


It is possible to make If/Loop statements in a way similar to that of creating blocks - by choosing an area of the picture, by clicking RMB on it and choosing “Make loop” from the pop-up menu. A dialog box will appear so that you’ll be able to choose loop/condition variable, it’s initial value and termination condition. To edit existing loops, choose Edit Loop from same pop-up menu.





5.3 Macros.


	WD PIC has it’s own predefined macros described in appendix B. As of now, the only way to declare your own macros is by direct typing into the PIC file.
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Appendix A - menus and actions index.








Main Menu


	File


		New  - lets you start a new work


Load - Opens a directory browser and lets you choose and 


load previously saved work


		Save - Opens a directory browser, lets you choose a file 


name and save your current work


		Quit  - quits the application


	Edit


		Undo - cancels last operation


		Redo - cancels last cancellation


		Cut - copies selected area to clipboard, 


removing it from the picture


		Copy - copies selected area to clipboard


		Delete - lets you delete selected area from the picture


		Paste - puts the clipboard contents into the picture


		Save Sample - lets you save clipboard contents as PIC file


		Load Sample - lets you load clipboard contents as PIC file


	View - toggles full screen view.


	Defaults


		v Gravity - gravity check box


		Box 		- here you can change box default attributes


		Arc		-	//		//   arc	//


		Line/Spline	-	//		// line/spline	//


		Arrow	-	//		//  arrow	//


		Move		-	//		//  move	//


		Circle		-	//		//  circle	//


		Ellipse	-	//		//   ellipse	//


		Text		- here you can set text style/size


		Grid		- here you can adjust grid size








Toolbox


	Box


LMB clicked - inserts default box to the file at current 


position


RMB clicked - open a dialog in which element properties can 


be specified


	…


	Ellipse	//			//			//








Line style palette


	RMB clicked - lets you define a new line style


	LMB clicked - make this line style current





Fill style palette


	RMB clicked - lets you define a new fill style


	LMB clicked - make this fill style current





